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Typographical conventions

Thefollowing typographical conventions are used in this manual.

commands

Typed commands and text as well as messages on non-graph-
ical screens or windows are shown in typewriter font. For ex-
ample, commands given to the UNIX shell are writtenin this
font:

show fiff -v online.fif

These commands should be typed exactly as shown, includ-
ing spaces, underscores, hyphens, slashes, punctuation etc.
only omitting the constructions denoting parameters (see be-
low). When using the graphical user interface, it is necessary
to open a terminal window first in order to type the com-
mands.

buttons and messages

The textual items of the graphical user interface are denoted
with bold Helvetica. The names of buttons, menus and menu
items and messages appearing on graphical windows are
shown in thisfont. For example:

Select Save averages... from File menu.

means using the mouse or arrow keysto point and activate the
menu labeled as “File”’, and then moving the pointer to an
item in this menu reading “ Save averages...” and selecting it.

names and parameters

Text in italics indicates the name of an application program,
manual, or other Neuromag item. Italicsis also used to intro-
duce new concepts and to emphasize words.

Parameters are marked with italicized text enclosed in angle
brackets (<,>). The whole construction, including the angle
brackets, should be replaced by the value of the parameter.
For example, in the shell command described as

show fiff [-v]<datafile>

the string <data file> is substituted with areal file name. Op-
tional parameters or arguments are enclosed in square brack-
ets.

NM21781A
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1. INTRODUCTION

1.1. Software structure

The acquisition software consists of severa software modules
running on the acquisition workstation and on the real-time com-
puter of the data acquisition unit. The workstation and the data
acquisition unit are interconnected through a dedicated local area
network.

The user interface of the acquisition system is completely on the
workstation while the data acquisition unit does not require any
direct user interaction. The software is based on client-server
architecture: programs providing user interfaces are clients of the
servers performing the corresponding actual tasks as instructed
by the clients. Most of the servers are running on the data acqui-
sition unit whereas the clients are running mainly on the acquisi-
tion workstation. Clients and servers communicate by using
network connections.

The components of the data-acquisition software arelisted below.
The corresponding UNIX process hames are indicated in paren-
thesis. Note that users don’t have to start all of these modules
explicitly; most of them are automatically managed by the data
acquisition control module and others are continuously running as
background processes.

1. The magnetometer electronics control server (janitor), EEG
control server (janitor_eeg), and the data collector server
(collector) on the real-time computer.

2. Dataserver module (dacq_server_peer) which receives data
from the real-time system and provides it to client processes
on the acquisition workstation.

3. Dataacquisition control module (megacq).

4. Raw datadisplay (rawdisp).

5. Real-time averaging (averager) and on-line average display
(xplotter) modules.

6. Head digitization server in the UNIX workstation (isotrak)
which communicates with the Isotrak 3D digitizer.

7. Head-position indicator data handling (hpi) and position fit-
ting (hpifit) modules.

8. Magnetometer tuning (Squiddler), and quality-assurance
software (noise_meas) in the acquisition workstation.

9. Liquid Helium level monitoring module (heliumd) and
Helium level history viewer and zero level estimation module
(helium).

10. Acquisition troubleshooting and maintenance utilities.

NM21781A
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1.2. Changes from previous edition / release

This is the first edition for data acquisition software release 3.4.
Thismanual isbased on the 5th edition of the previous acquisition
system manual.

NM21781A Introduction 2



Elekta Neuromag DATA ACQUISITION

2. GETTING STARTED

2.1. Hardware checklist

Before starting a measurement:
1. Check that you have a set of at least three HPI coilsavailable.

2. Check that the evoked-response stimulation hardware is
properly set up, if needed.

3. Check that the necessary electrodes are available for record-
ing electric signals.

2.2. Starting the software

2

-

/
Acguisition

All the Neuromag analysis and data acquisition application pro-
grams are started by double clicking the corresponding icon in the
Neuromag toolbox. If this toolbox is not on your desktop, open
it by first clicking the tools subpanel on the right side of CDE
front panel (see HP Common Desktop Environment: User’s
Guide for details) and then double-clicking the Neuromag icon.

Once the Neuromag toolbox is open the data acquisition control
program (megacq) is started by double clicking the Acquisition
icon. In addition to the main window, the raw data display appears
(see Section 6.3. on page 37).

On start-up, megacq checksthe integrity of the data path from the
data acquisition system to the UNIX workstation. If no connec-
tion exists, you will see an error dialog indicating the failure.
Should this happen, check first that the data acquisition computer
is switched on (see Technical manual: System hardware). A pos-
sible software problem causing the error can be resolved by the
procedure described in Section 9. on page 53.

The Elekta Neuromag (V ectorview) system is aways fully pow-
ered whereas Neuromag-122 system is turned on automatically
by megacqg. Additionally, with the Neuromag-122 systems, if the
automatic loading of sensor tuning parametersis enabled, megacq
measures the liquid Helium level and chooses the closest match-
ing sensor tuning parameter file from the / neur o/ dacq/

t uni ng directory. The tuning files have to be named as
He <level>. set up, where<level>isexpressedin per centsand
with three digits. For example, the tuning file for 50% liquid
Helium level would be called He_050. set up. See Squiddler
Program Manual in Technical Manual: System Hardware for
details about saving tuning files.

Before proceeding it is advisable to check the avail able disk space
on data volumes from Disk space... inthe Tools menu.

NM21781A
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2.3. Components of the control program

The main window of megacq consists of:

— Acquisition: control

File QOn-line Tools

wkup ... 200 Connection open

use meg ... 200 MEG system selected
powr on ... 200 Power is now on

He level is 32%. Loaded He_27.

Change Project: not specified!

Change  Subject: not entered!

Chang ; 0.03 .. 100 00.0 Hz, 128 channels
Change External stimulus generation,

Change On-line averaging: not active.

Change HPI: not digitized!

Acquisition controls

GO! [ Stimulate [~

good news.
data recorded.
Averager not active
Mothing rejected
Mo news fram HPI

1. The menubar with File, On-line, Tools, and Help menus.
2. A log window for informational messages.

3. The setup buttons with a synopsis of the setup state indicated
in to the right of each button.

4. Acquisition control buttons, which are enabled and disabled
according to the state of the acquisition process.

5. A stopwatch for measuring time.

6. Five status message lines indicating the state of the acquisi-
tion.

2.3.1. Themenus

The items in the File menu store and recall measurement param-
etersfromfiles, thusfacilitating setting up for ameasurement. See
Section 3.6. “Saving and restoring settings’ on page 23 and Sec-
tion 5. “ Experiment preparation” on page 31 for the details of the
items in this menu. Finally, there is Quit for exiting the acquisi-
tion system.

NM21781A
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The On-line menu contains functions which control the on-line
averager and the on-line average display during a measurement.
See Section 6.4. “ On-line averaging” on page 42 for adescription
of this menu.

Most of the functionsin the Tools menu control the magnetome-
ter probe:

Reset channels

Reset the MEG and EEG channels. To ensure fast settling of
the signals after resetting the electronics the digital high-pass
filter isautomatically switched to ahigh corner frequency for
a couple of seconds and then back to the setup value.

A reset is applied automatically when a measurements starts,
so this function is intended for recovering channels after an
excessive disturbance during a measurement.

Load setup...

Load a Helium level dependent sensor tuning parameter file.
This can optionally be automatically done when megacq is
started (see Section 2.2.). Only for Neuromag-122.

Tuner...
Invoke the automatic sensor tuner.
Squiddler...

Invoke the manual sensor tuner, which alows modifying,
loading and saving tuning parameters, and de-trapping (heat-
ing) the sensors. Refer to Technical Manual: System Hard-
ware for instructions how to tune the sensors. Squiddler can
also be started independently of megacq by using the corre-
sponding icon in the Maintenance folder in the Neuromag
toolbox.

Squiddler_EEG...

Invoke the EEG hardware (Vectorview) or EEG filter (Neu-
romag-122) control program. The applicability of this
depends on the configuration of the particular system.

Helium level...

Show the liquid Helium level history and estimated zero-
level time. This can be done also by clicking the Helium-
Level icon in the Neuromag toolbox or by issuing the com-
mand hel i umat a command line (provided that the search
path of the UNIX shell includes the directory / neur o/
bi n).

Disk space...
Show the available disk space on all mounted volumes.

NM21781A
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2.4. Closing the software

When the measurements are completed and the all the necessary
data saved, the acquisition system user interface can be closed to
release computer resources for other tasks. To close the acquisi-
tion programs select Quit in the File menu of megacg. Y ou will
be asked for a confirmation.

All the child applications of megacq (Raw data display, Average
response display etc.) will close automatically. In Neuromag-122
systems, megacq will then ask weather the magnetometer elec-
tronics should be | eft powered on or turned off. Usually it is pref-
erable to keep the electronics on also between measurement
sessions; the system requires some minutes to completely stabi-
lize after a power-up.

The state of megacq is not automatically saved when closing it.
Thus, you have to explicitly use the procedures explained in Sec-
tion 3.6. “Saving and restoring settings’ on page 23 if you want to
continue using the same parameters.

Note that exiting megacq only closesthe user interface of the data
acquisition system, while the real-time system remains powered
on and running. The real-time system is shut down only during
service operations.

NM21781A
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3. SETTING UP
This section describes the setup tasks to be performed before
starting the acquisition. If the persona data of the subject are
available, the setup can be completed before the subject arrives.
3.1. Project

The measured dataare grouped into projects according to the con-
ventions at each site. For example, one project might correspond
to agroup of patients with common symptoms or patients inves-
tigated by one clinician.

The project is selected from the project dialog which appears
when the project setup button is pressed.

If you are collecting datato an already existing project, just select
the project name from the list and press OK or double click the
project name.

NM21781A Setting up 7
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If you are defining anew project, select the item <new> from the
list and enter the project name and other reference information in
the text entry areas. The project name may consist of lowercase
letters and the underscore character. In addition to the project
name, aims and names of responsible persons are required for the
definition of a new project.

If you are changing to No project double click the item <new>.
If you want to close the project dialog without changing anything
press Cancel.

There are two useful keyboard shortcuts in the project list. First,
you can go to the <new> item by clicking any of the items and
then pressing the home key with control down. Second, you can
browse the list alphabetically by clicking any of the items and
then pressing a letter key. The list will move to the first project
whose last name begins with this letter.

3.2. Subject
3.2.1. The subject list

Subject definition is analogous to the project definition. The
names of already existing subjects are listed a phabeticaly at the
top of the dialog.

— This is so wonderful

Available subjects :

Subjecttype : Volunteers —

Doe uhn

Subject name :

Last : |}
First @ ¢

Middle : |7

Date of hirth :

day |7 month |7 year !

Subject dimensions :

height |7 weight |

Other information :

Sex Male 1D # : 0002
Handedness :  Right HIsID: §

Comments :

Ok Cancel Help

If you are collecting data from an aready existing subject, just
select the subject name from the list and press OK or double click
the subject name.

NM21781A Setting up 8
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To define anew subject, select theitem <new> from thelist, enter
the information to the text fields, select the appropriate choices,
and pressOK. Y ou arerequired to enter thefirst and the last name.
Exercise care not to define the same subject twice as a double-
entry may confusethe MEG/MRI subject matching intheanalysis
programs.

Weight and height are optional whereas handedness and sex are
always taken from the corresponding option menus. Hospital
Information System (HIS) ID is intended for a hospital-wide
patient code, such as social security number, which uniquely
identifies the subject. HIS ID is stored with each data file and it
can be used as a component in the path for the files saved by the

If you are changing to No subject double click the item <new>.
If you want to close the subject dialog without changing anything
press Cancel.

The keyboard shortcuts in the subject list are identical to those in
the project list.

3.2.2. Volunteersand patients

Sites studying patients would often like to protect patient infor-
mation from unauthorized access. megacq provides a grouping of
persons to be studied to ‘volunteers’ and ‘ patients'.

Volunteers are healthy subjects participating in the MEG studies.
When a person is classified as volunteer, megacq applies no spe-
cial protection on his data:

1. The personal data of a volunteer can be read by any user in
megacq. All personal information is included with the mea-
sured data.

2. Thedatawill be saved - by default - in directories

<project>/ <last name>_<first name>/ <date>,

asdiscussed in Section 7.1. on page 46. All directories on the
path are accessible to any user.

For a person classified as a patient, the following protective mea-
sures are taken:

1. Only the patient id number will be written to the data files.
The data files will contain case as the patient’s first name
and the id number as the last name. Therefore, if you list the
person’sname from adatafileit will be something likecase
567.

2. Thedatawill be saved - by default - in directories

<project>/ case_<id>/ <date>.

3. The creator of the patient chooses the access restrictions
which apply to the personal data of the patient entered and to
the MEG and EEG data saved.

NM21781A
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In the strict access mode, the data are only readable by the
creator of the patient.

In the group access mode, read and write access to the patient
data is additionally granted to a designated group of UNIX
users.

The choice between volunteers and patients is made in the subject
definition dialog. When the option menu at the top of the dialog
isset to Volunteers, all volunteers are listed.

— Available subjects :

Zubject type : Volunteers —

Doe John

Zubject name :

When themenuisset to Patients all patients accessibleto the cur-
rent user are listed.

Available subjects :

Zubject t-,-'pe: Patients
Accessible to group: Mone

Alzheimer Albert A

If you have created the patient, the Accessible to group: option
menu becomes undimmed.

Available subjects :

Zubject t-,-'pe: Patients
Accessible to group

Alzheimer Albert A

If the choiceisNone the data of this patient are only accessibleto
you. If you select agroup of users, the data become accessible to
thisgroup aswell. Please consult your system administrator if you
need a new group of users. To avoid confusion, the number of
groups should be kept as small as possible.

NM21781A
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A\

War ning!

If you have restarted the acquisition software as described in Sec-
tion 9. on page 53, you can reuse earlier HPI data when megacq
isrestarted. However, you can change the subject only once (from
No subject to some of the available subjects) without losing the
HPI data.

3.3. Acquisition

The acquisition setup dialog, which appears when the acquisition
setup button is pressed adjusts the following:

-

L = S

1. The selection of channels to be acquired.

The channels are switched on and off from the buttons in the
upper part of the dialog. The stimulusinput and HPI synchro-
nization channels are permanently selected. Therefore, the
corresponding buttons are grayed out indicating that their
states cannot be changed.

NM21781A Setting up 11
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A\

Warning

All MEG channels are selected by default. Switching any of them
off should be done with caution. It is better to ignore malfunction-
ing channels in the analysis software instead of not recording
them at al. This enables e.g. cheking if aretefacts on other chan-
nels are due to malfuctioning channel. Also HPI and SSP work
best with all channels enabled. In addition, some third party anal-
ysis tools assume all channels to be present in the datafile.

The number of electric input channelsis system specific. Itis
typically 64.

Each of the electric channels can serve either as an EEG,
ECG, EMG, EOG, or a miscellaneous input. The input chan-
nel type of each electric channel can be changed from apopup
menu attached to each of the electric channel buttons. By
default, holding down the right mouse button while pointing
to an electric channel button brings up this menu.

Typicaly, EEG hardware channels 1 - 60 are unipolar and 61
- 64 are bipolar. Only the latter ones should be used as ECG,
EMG, EOG channels.

The change of the input type only affects the channel name.
This is often useful in later stages of analysis. For example,
xplotter, the plotting program, may be set up to lay out the
EOG channelsin an invariable way. Also, the scales of vari-
ous el ectric channel types can be separately set in xplotter and
in the raw data display.

The sampling frequency.
The sampling frequency, f, is set with a dider below the
channel selectors.

The maximum allowed sampling rate depends on the data
acquisition hardware and on the selection of channels and
their actual distribution between the analog-to-digital con-
vertersin the dataacquisition unit. The maximum on the sam-
pling frequency slider automatically reflects the limitation
imposed by the hardware. Some systems have two sampling
frequency ranges. In these systems sampling frequencies
above a device dependent limit are recorded in “playback
mode”, where the datais first saved in the front end and then
“played back” with a slower pace which the workstation can
handle.

The actual sampling rate may dlightly differ from the selected
one because of limitationsin the hardware. However, the real
sampling rate is reported in the datafiles.

NM21781A Setting up 12
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Low-pass filter

The low-pass filter corner frequency, f , is set with aslider to

the right of the sampling frequency slider. For more detailed
low-pass filter specifications consult the hardware manuals.

According to the Nyqvist criterion, the sampling frequency
should be at least twice the highest frequency component in
the analog signal, f_> 2f_to avoid aliasing. Since analog fil-
terscannot have aninfinitely steep transition at the corner fre-
quency, megacq adds asafety margin and only allowsf_> 3f .

High-pass filter
The corner frequency of the high-pass filter can be set in

steps. The available corner frequencies are shown next to the
toggle buttons provided for selecting the filter.

Raw data baseline

With this option, it is possible to define the amount of datato
be saved preceding the time when raw data saving was
switched on. The length of this *baseline’ will be at least the
indicated amount. The maximum length of the baselineis 15
seconds.

| mportant!

With custom/3rd party EEG amplifiers, EEG filters may have to
be set manually. The EEG low-passfilter corner frequency should
not exceed one third of the sampling frequency to avoid aliasing.

NM21781A Setting up 13
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3.4. Stimuli and triggers

The stimulus setup dialog appears when you press the stimulus
setup button

~| Stimulus setup

# length/ms 151ims

LL-|

5: I

10: I

Load...| Save...| Generate...|

(® Internal stimulus generation

) External stimulus generation

Ok | Cancel| Help |

3.4.1. Trigger interfacesand triggering modes

The stimulus triggers that generate events (see Section 3.5.1. on
page 17) for the acquisition software can be provided either by the
data acquisition unit or by an external stimulation system. The
acquisition software processes the trigger signals exactly in the
same way, independent of their origin.

The electric interface of the trigger signals is called a Remote
Trigger Unit, which is connected to the System Control Card
(SCC) housed in the data acquisition system cabinet. Elekta Neu-
romag systems include two Remote Trigger Units, which by
default operate in paraléd, i.e. input #1 and output #1 on both
Remote Trigger Units refer to trigger line #1 on the trigger chan-
nel (ST1101) associated with the 1st interface unit, however, the
two interfaces can be treated separately by turning on (selecting
for acquisition) also the trigger channel (ST1102) associated with
the 2nd interface unit.

For details about the Remote Trigger Unit and for electrical spec-
ifications of the trigger pulses, see User’s Manual: System Hard-
ware and Technical Manual: System Hardware.

NM21781A
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Remote Unit A

ut

Remote Unit B

ut

Ay

Ay

The SCC manages both internal and external triggers. Irrespective
of the triggering mode (internal/external) the trigger pulses
always appear at the corresponding trigger outputs of both
Remote Trigger Units. The principleisshown in thefigure below.

Internally generated
triggers

L Acquisition

Internally generated trigger pulses and the pulses acquired from
external sources arelogically OR’ed line by line. The duration of
the resulting pulse isfixed, and the pulseis fed to the acquisition
system and to the trigger outputs. Thus the system automatically
‘chooses’ theright source for each trigger channel provided that a
trigger channel is not receiving pulses both from internal and
external sources at the same time. Should this happen, pulsesfrom
those two or three sources will be intermixed and indistinguish-
able at further processing stages.

Typically the trigger event is associated with the rising edge of
trigger pulse, however, the off-line analysis tools can be config-
ured to also monitor the falling edge. Note that the timing of the
falling edge does not accurately reflect any physical event in sys-
tems which incorporate circuitry that fixes the pulse length.

If you prefer external triggering, turn the switch to the external
position and connect a TTL level trigger pulse output from your
stimulation system to the trigger input.

The stimulus setup dialog selects the trigger source from the soft-
ware point of view: if internal triggering is selected, you are
allowed to define a stimulus sequence.

NM21781A
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3.4.2. Stimulus sequence

The maximum length of the internal stimulus sequence is 500
stimuli. Each item in the sequence is defined by the trigger num-
ber (1 — 16), the length of the trigger pulse (ms), and the length of
theinterval from the start of the trigger to the next. Thisperiod is
often called the inter-stimulus interval (1SI).

The stimulus sequence can be either entered manually, generated
with help of the sequence generator, or loaded from afile.

3.4.3. Sequence generator

The sequence generator utility is accessed trough the Generate
button in the stimulus definition dialog.

Stimulus sequence generator

Y ou can create several kinds of sequences:
1. Anadlternating sequence

Given number of stimuli, n, are repeated sequentially:
1,2,...,n,1,2,.....n,... If thelSI limitsare equal, the | Sl remains
constant; if they are different, the ISI’ s are random within the
interval with a uniform probability density.

2. Random sequence

The given number of stimuli have an equal probability to
occur in the random sequence. The handling of 1SI's is the
same as in the alternating sequence.

3. Mismatch sequence

Stimulus 2 (deviant) occurs randomly in a monotonous
sequence of stimulus 1 (standard) with the given probability.
If the deviant probability islessthan 15 percent or higher than
85 percent, two deviant stimuli will never occur sequentially.
If the deviant probability is higher than 85 percent, stimulus
1 is considered to be the deviant when this rule is applied.
ISI’s are generated as above.

Once you click Generate, the sequence is generated and the val-
ues are entered into the stimulus sequence table.

NM21781A
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3.4.4. Loading and saving sequences

Y ou can load stimulus sequences from text files and save existing
sequences for future retrieval. By default, the stimulus-sequence
filesare stored in the directory / neur o/ dacqg/ stim

You can also generate sequence files yourself either with a text
editor or with a program. The sequence file ssimply replicates the
sequence table:

<trigger #1> <length /ms> <I9S 1/ms>
<trigger #2> <length 2/ms> <IS 2/ms>

Space, tab, and newline are allowed as separator characters
between the numbers. Although megacq writes the data three
numbers per line to mimic the layout of the table, you can store as
many numbers per line as you like as long as they are separated
by one or more of the separator characters.

3.5. On-line averaging

3.5.1. Basics

The most complex part of the acquisition setup concerns on-line
averaging. For the discussion to follow we need to define a few
relevant conceptsfirst.

Trigger channel

An electric impulse carrying solely timing information and
occurring on asingle digital lineis called atrigger. A trigger
could be used to drive a stimulator to produce a stimulus, or
it could reflect subject’ s behavioral response. The system has
severa trigger channelsfor transmitting and receiving trigger
pulses. Trigger channels are managed by the system
described in Section 3.4.1. The output of that system controls
the on-line averager.

Event

A transition from an inactive to active state or vice versa on
one or more trigger linesis an event. Although all events are
recorded in the data files, megacq only considers events
where all trigger lines are inactive at sample k and some of
them are active at sample k + 1. The source of an event can
be either a stimulus trigger or a trigger associated with an
action performed by the subject, such as a button press.

For backwards compatibility, the default definitions of the
events correspond to the transitions on the trigger lines asfol-

lows:

Event # Trigger lines to activate
1 1
2 2
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3 3

4 4

5 5

6 6

7 1&2

8 1&3

9 2& 3

10 1&2&3
11 1&4

12 2& 4

13 1&82& 4
14 3& 4

15 1&3&4
16 2&3&4
17 1&2&3&4

User can reconfigure this map to fit his’her needs. To change
the mapping, open the event editor in the on-line averager
setup by pressing the Change button and set the bit patterns
and masks for the desired previous and new state of the cho-
sen trigger channel. The event name can also be changed to
be more descriptive (spaces not allowed).

~| Edit event 1

Characteristics of an event:

Mame: 1 Channel: 5T 014 —

Yalue / Mask =010203040506070803101112 13141516
el 5o alolo[ole[o][x[]+]<] <[]
o 5 |ss o]o]o]o[o]o[ ][]/

Delay to stimulus (ms): 10

Comment | Event # 1

014 Cancel Help

To avoid misinterpretations of the trigger combinations due
to race conditions, the following procedureisimplemented in
the on-line averager. Assume sample k with al trigger lines
inactive followed by sample k + 1 having one or more active
trigger lines. Samplek + 1 isused asthe timing reference, but
the trigger line combination is determined from samplek + 2.
This allows a dlight asynchrony between the on-sets of the
trigger lines.

Epoch

An epoch is a section of the incoming continuous data,
defined by the occurrence of an event and the time limitst
andt__ withrespect to that event. Wewill call the event deter-
mining the zero time of an epoch atrigger event.
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Category
A category defines the epoch to be averaged, any additional
conditions to averaging, and the processing of epochs during
averaging. For example, some categories may be set up to
produce, in addition to the standard average, several subaver-
ages of, say, eight consecutive epochs each.

3.5.2. Categories

The maximum number of categories is presently set to 20. They
are defined in the upper section of the on-line averaging dialog,
which appears upon a click to the on-line averaging setup button.

Thefollowing items are displayed as one linefor each category in
the upper section of the window:

On-off toggle

A toggle button to activate and deactivate a category. Y ou can
often define all categories you need in a study consisting of
several consecutive acquisitions and then just switch the cat-
egories on and off as needed.
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Display on-off toggle

Thistoggle button sets the on-line display state of a category.
The states of these buttons define the initial selection of cate-
gories displayed in the xplotter window during averaging.
The selection of displayed data can be modified during acqui-
sition as discussed in Sect. 6.4.4. However, when the acquisi-
tion is finished, the final results from any categories which
have one or more epochs averaged will be displayed regard-
less of the on-line display selection. Note also that any
changes made to the on-line display selection during the data
collection will remain in effect for the subsequent acquisi-
tions.

Change..

This button invokes adialog to define the characteristics of a
category.

Description
A text describing the properties currently selected for this cat-
egory from the category definition dialog.

The dialog appearing from the Change... button contains the
controls

— Edit category 1

Parameters of an averaging category:
Fef. event: I 1(1) m—  tmin(ms): 50 tmax (ms): B
Feg. event: I Mone before —  Within (ms) _

Desired # of averages : | i Subave. size : _
Ll | Category # 1

Ref. event:

An option menu to select the trigger event. The event is con-
sidered as the zero-time point, with the optional stimulus
delay compensation taken into account (see the following
subsection on Events). The event name list reflects the
defined eventsin the top part of the on-line averager window.

Req. event:
An option menu to select a condition event and an option

menu with the choices Never, Before, and After. If the choice
is Never, the condition event is not used.
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tmin:

The start time of the averaging window with respect to the
reference event. This value can be negative (prior to the
occurence of the reference event) or positive (after the
occurence of the reference event).

tmax:

The end time of the averaging window with respect to the ref-
erence event.

Within:

The time range within which the condition event must occur
in order for an epoch to match this category. If the When
menu is set to Before, the condition event must occur before
thetrigger event. If After isselected, the condition event must
occur after the trigger event.

Desired # of averages:

If this number is zero or negative, the number of epochs aver-
aged is controlled manually, see Section 6.1. on page 33.

If the setting is positive, averaging is automatically sus-
pended when the desired number of averagesisreached. You
can then either continue averaging manually or stop the mea-
surement.

If several categories have the desired number of averages set,
thefirst one to reach the limit causes the averaging to be sus-
pended. Other limits not satisfied remain active. Therefore, if
you continue averaging manually, the averaging will be again
suspended if some other category reaches the limit.

Subave. size:

If this number is set to an even value M > 0 both normal and
alternating subaverages are computed consisting of M
epochs. If we denote the epochs by g(t), the jth normal and

alternating subaverages are

M
e () = Z e, (t)and
k=1+(-1)M

a k+1
~ +
ORI W VO]
k=1+(-1)M
respectively.
Comment:

A text entry field to annotate a category with acomment. The
comment is shown when new data are loaded for plotting and
source modeling.
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3.5.3. Events

The second section of the on-line averaging dialog allows you to
assign commentsto the events and to define adelay from the state
change of the trigger input line to the actual stimulus. For exam-
ple, if you have plastic tubes with known transmission delays
leading auditory stimuli to the subject’ s ears, enter the delay here
to set the time scale of the responses correctly. The delay must be
defined positive if the stimulus occurs after the trigger and nega-
tive if it occurs before the trigger.

Notel

As described in Section 3.5.1., the event numbering does not
directly relate to numbers of categories. For example, event # 1
may be used as a trigger in several categories, not necessarily
including category # 1. Therefore, if you adjust the delays of some
events, keep in mind that event # 5 is not always triggering cate-
gory #5.

3.5.4. Artefact regjection

There are three kinds of artefact rejection criteria available for
MEG and EEG channels:

Amplitude

The peak-to-peak amplitude within an epoch must not exceed
this value. Recommended value is 3000 fT/cm.

Slope

The epoch is subdivided into four equally long pieces. The
averages over each piece is calculated. None of the three dif-
ferences between subsequent partial averages must not
exceed this value. Be default, this criterion is not in use.

Spike

The absolute value of the difference between any sampled
valuein an epoch and the average of 20 previous values must
not be larger than this. By default, this criterion isnot in use.

The above criteria are applied to all channels. If a channel not
meeting the criteria throughout the epoch is found, the epoch is
rejected. Some channels can be excluded from the artefact rejec-
tion during acquisition, see Section 6.4.3.

If anegative valueisentered to an artefact rejection field, the cor-
responding criterion is not applied.

EOG, EMG, and ECG rejectionisonly possible on the basis of the
amplitude criterion.
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In addition to the above criteria, an epoch up to agiven timeinter-
val after the reference event can be excluded from the rejection
(Ignore ms after stim). Thisisuseful if astrong stimulus artefact
is expected.

3.5.5. Noisy and silent channels

The above artefact criteria are applied in a transient manner.
Every epoch is checked against the above criteriato see whether
the conditions can be met. However, it sometimes happens that
few MEG channels are either showing no signal or are very noisy.
There are two additional parameters to check these channels:
MEG no signal and MEG noisy.

If the peak-to-peak amplitude of a channel is less than the MEG
no signal limit or larger than the MEG noisy limit, the channel
will be omitted from further artefact checking during the current
and all subsequent epochs. The noisy and silent channels so
detected will be marked ‘bad’ in the resulting evoked-response
datafiles.

The signals of “noisy” or “silent” channels are stored in the very
same way as those of any other channels; the automatic detection
only affects rejection checking.

3.5.6. On-line display updates

During on-line averaging the progress is displayed by showing
data averaged so far in the standard plotting program (xplotter).

By default this display is updated every 15 seconds. You may
want to set this value higher in order to work with the data
between updates. It is also advisable to set the update interval
higher if the 1Sl is small (< 500 ms), if the sampling rate is high
(> 1 kHz), the epochs are long (> 2 s), or if many categories are
selected to the on-line display. If the updates are too frequent, the
on-line averaging may not proceed in real-time and, conse-
guently, you may haveto wait at the end of the acquisition for on-
line averaging to complete.

3.6. Saving and restoring settings

All of the above settings apart from the project and subject data
can be saved between sessions. There is a separate set of settings
for each project. Therefore, you cannot save or load settings until

the project is selected.

Settings are saved and loaded from the Save settings... and
Load settings... itemsin the File menu. When you save settings
you must provide a descriptive name for the setup. This name is
shown in the list of available settings when you load the settings
back later.
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The settings are al so included with the measured data. By choos-

ing Load measurement settings... from the File menu you can

locate adatafile and load settingsfrom there. Thisoptionisuseful

if

1. Youwouldliketo replicate ameasurement with identical set-
tings.

2. Youwould like to check the actual settings used afterwards.

Note that the Head digitization data (see Section 4. on page 26)
are not stored in the settings nor can they be loaded from a data
file. On the contrary, subject preparation information includes
everything that is in the settings as well as the digitization data.
Y ou can create a preparation from the current setup and digitiza-
tion by choosing Save preparation from the File menu and recall
it later by Load normal preparation... See Section 5. on page 31
for more details.

3.7. On-line signal space projection

3.7.1. Background

External magnetic disturbances which have fairly uniform distri-
bution but varying amplitudes can be suppressed by the signal
space projection (SSP) technique.

The measured signals span a signal space whose dimension
equals the number of channels n being measured. Thus, at each
sampling point in time, the signals can be described as avector in
the signal space. For agiven distribution or field topology the sig-
nal vector points to the same direction but its length varies as the
amplitudes of the signals change. Once the distribution(s) corre-
sponding to a disturbance are known a suppressing SSP operator
can be constructed from the distributions (refer to the Sgnal Pro-
cessor Reference Manual for details). The operator ‘rotates each
sample vector in the signal space so that the disturbance becomes
orthogonal to the n-1 dimensional hyperplane in the signal space
and thus disappears. The drawback is losing one degree of free-
dom, i.e., one independent measurement, and the slight deforma-
tion of response patterns if viewed without a subsequent
reconstruction.

Since the topology of external disturbances at a particular site is
typically constant to a good approximation, it is not necessary to
define the SSP operator individually for each measurement, if the
magnetometer probeis at afixed location and orientation.

3.7.2. Setting up for on-line SSP
An SSP operator contained in the file

/I neuro/ssp/online.fif
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will automatically be included in all raw data and average files
measured by the system. If that file doesn’'t exist or if it doesn’t
contain an SSP operator, the on-line SSP is silently turned off.
The Sgnal Processor Reference Manual includesinstructions for
defining the projection and creating the file mentioned above.

Note that the data are always stored intact, but the operator is
optionally included in the data file, so that various data viewers
and analysis programs can take it into account, or at request, show
the non-projected origina data.

3.7.3. SSP and the on-line aver ager

Since averaging and projection are both linear operations and thus
commute, projection can be done only to the final average. The
on-line averager attaches the SSP operator to the output average
filebut leavesthe actual signal intact, i.e., un-projected. The visu-
alization software is responsible for applying the SSP operator to
the data.

The rejection checking of the on-line averager, however, uses
SSP-filtered data.
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4. HEAD DIGITIZATION

4.1. Coordinate frames

The Neuromag-122 and V ectorview systemsinternally use device
coordinate system. The recorded signals represent field compo-
nents at fixed sensor locations in the device coordinate system.
The origin of this coordinate system islocated at the center of the
posterior spherical part of the helmet with y-axis pointing from
back to front, x-axisfrom left to right and z-axis pointing up. Thus
the position of subject’ shead in respect to the measurement probe
does not affect the way the signals are recorded.

Source modeling calculations are also done in the device coordi-
nate system. However, the results are automatically transformed
into a more relevant coordinate system, namely into the head
coor dinate system (al so called the anatomical coordinate system).
Thisisessential in order to integrate the source model into an ana-
tomical image, e.g., magnetic resonance image.

The head coordinate system is defined as follows: The x-axis
passes through the preauricular points with positive values on the
right, the y-axis will be perpendicular to the x-axis, passing
through the nasion and the positive axis pointing towards the
nose, and the z-axis will point up, perpendicular to the xy-plane.
Thisisillustrated in figure below. LPA and RPA stand for the left
and right peri- or preauricular points, respectively. LPA, RPA and
nasion are called the anatomical landmarks or cardinal points.

z

A

RPA

Nasion LpA
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To establish the coordinate transformation between the head
coordinate system and the device coordinate system the anatomi-
cal landmarks have to expressed in the device coordinate system.
Thisis done indirectly by using markers (head-position indicator
coils) whose locations can be measured with respect to the ana-
tomical system and also with respect to the device coordinate sys-
tem. The former measurement is called Head digitization and the
latter HPI measurement. The combination of these two measure-
ments resultsin a coordinate transformation between device coor-
dinate system and head coordinate system.

4.2. Digitization

The final task before starting the measurement is the digitization
of the anatomical landmarks on the head and the position of the
head-position indicator (HPI) coils with respect to them.

When you click the HPI setup button, megacq connectsto and ini-
tializes the Isotrak™ digitizer used for this purpose. Isotrak ini-
tialization takes a few seconds. Y ou are informed about thisin a
dialog. Oncetheinitialization is complete the HPI dialog appears:

The left section of the dialog contains the controls for the tasks
which are necessary to complete the HPI procedure. The right
section contains controls for optional items. The label above the
dialog buttonswill dynamically indicate the task to be performed
next.

Proceed as follows with the digitization:

1. Attach the HPI coils on the head. Typically the coils are
placed so that two are behind the ears as high as possible
without being on the hair, and two on the forehead well sepa-
rated but not on the hair. The system does not restrict the coil
locations provided that they are covered by the MEG sensor
array and do not move during the measurement. The most
precise HPI information is obtained when the coils are as far
apart as possible but still within the sensor helmet.

2. Thedigitization system is equipped with goggles which track
head movements during the digitization. Place the goggles
firmly on the subject’ s head and tighten the strap. Check that
nasion and the coil centers are still accessible with the I sotrak
stylus.

3. Make sure the digitization chair is sufficiently far (over 1.5
m) from large metal objects as they severely distort the digi-
tizer and compromise its accuracy. Tell the subject to avoid
excessive head movement.

4. Digitize the anatomical landmarks: the nasion and the two
auricular points. Depending on your preferences you may use
either peri-auricular or pre-auricular points. Be sure to record
which points were used to be able to correctly identify them
later on the anatomical MRI’s.
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Head shape digitization

To digitize, position the tip of the Isotrak stylus at the desired
point and click the corresponding button in the HPI dialog. It
is best to have two people available for the digitization: one
to position the stylus and another to operate the program.
Alternatively, the stylus button can be used for the digitiza-
tion: click the Coordinate frame alignment button to start
the “single operator” mode. Then digitize the landmarks in
any order; the system will automatically associate the points
with proper landmarks.
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The coordinates next to each button indicate the digitized
position in acoordinate frametied to the I sotrak signal source
behind the chair. The results are averages of three sequential
readings taken from the digitizer. If they differ from each
other by morethan 2 mm, an error messagetelling to keep the
pointer steady appears and you can re-digitize the point.

When the digitization of the cardinal pointsiscomplete, press
the Align frame button (the alignment is done automatically
when operating with the stylus button and all three landmarks
are digitized). The coordinates of subsequent readingswill be
given in the head coordinate frame, tied to the cardinal 1and-
marks.

When Align frame is pressed, the coordinates of the cardinal
locations will change to the head frame. Notice that the z
coordinates of all three points are zero. The y coordinates of
the auricular points are zero with a positive x coordinate on
the right and a negative on the left auricular point, respec-
tively. The nasion has azero x coordinate and itsy coordinate
is positive. The auricular points are usualy rather symmetri-
cally located: their x coordinates are opposite and about of
equal magnitude. This serves as an additional check that the
digitized values are reasonable.

Digitize the HPI coils (order does not matter).

If scalp EEG channels are selected for acquisition, the pro-
gram moves on to digitize the EEG electrode locations. Alter-
native electrode digitization sequences for different EEG
caps can be configured; the proper one can be selected in the
EEG digitization quadrant of the window. The default is to
digitize in the ascendent channel number order, starting from
the reference electrode.

Y ou can digitize additional pointsto obtain information about
the head shape, which allows more accurate alignment with
the anatomical MRIs. Press Man to digitize the location of the
stylusinthe*two operator” mode or Pen to usethe stylus but-
ton. Select one or more of the digitized extra points from the
list and press Delete to remove unneeded entries. Select two
points in the list and press Dist? to find out the distance
between the selected points. The coordinates of the additional
points will be included into the measurement files. Once you
have completed the digitization, press OK.

The digitization procedure and other pre-measurement setups can
be performed also on a workstation other than the acquisition
workstation even when there is a measurement in progress. See
“Experiment preparation” on page 31 for more information.
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A\

| mportant!

If you press Cancel in the dialog you will loose al the digitized
data. A warning dialog will appear to confirm this.
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5. EXPERIMENT PREPARATION

As discussed in Section 3.6., the acquisition and averaging
parameters can be saved between sessions using the Save set-
tings... and Load settings... itemsin the File menu. Therefore,
agiven experimenta paradigm can be easily repeated.

It is often beneficial to save all measurement parameters, includ-
ing the project and subject selections, all acquisition and averag-
ing parameters, and the head digitization data for subsequent use.
This complete set of information is called a preparation.

5.1. Restricted megacq

Preparefcouisition

An experiment can be prepared either from the standard megacq
or from its restricted version. The restricted version is started by
double clicking the PrepareAcquisition icon in the Neuromag
tool box.

— Subject preparation A

File On-line Tools

Settings

Change | Project: not specified!
Change | Zubject: not entered!

Change | Acquisition: 0.03.. 100Hz @ 400.0 Hz, 127 channels

Change | External stimulus generation.
Change | On-line averaging: not active.

Change | HFI: not digitized!

Therestricted megacq does not communicate with the acquisition
system., and the acquisition control buttons (see Section 6.1.) are
absent. A new experiment can be prepared from another worksta-
tion while data are being collected at the acquisition workstation.
The experiment preparation workstation hasto be located near the
Isotrak™ digitizer for feasible digitization.

Note!

You can also use the restricted megacq to check information
about a subject or a project during off-line analysis without dis-
turbing the measurement.
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5.2. Saving a preparation

Before you can save a preparation, you will have to complete the
following steps:

1. Select aproject
2. Select asubject

3. Enter the acquisition, stimulus, and averaging parameters or
load one of the settings available for the selected project.

4. Perform the head digitization.

With all the above data complete you can save the preparation by
selecting Save preparation from the File menu. If some of the
required datais missing an error dialog will appear. If al datais
present, the preparation will be saved. Y ou will beinformed about
the name given to the preparation. The name is of the form

<project name> / <subject name> / <date> <time>.

A saved preparation will be kept for 24 hours from its creation
time. Whenever megacq or its restricted version is started, the
preparation database is checked for old preparations which are
automatically discarded.

Please note that using the head digitization data from the prepara-
tion is only meaningful if the HPI coils are kept attached on the
subjects head from the preparation time to the actual measure-
ment.

5.3. Loading a saved preparation

When Load normal preparation... is selected from the File
menu, alist of available experiment preparationswill appear. Y ou
can easily identify the desired one from the descriptive name.
Please be careful to select the correct one. Thereisno way for the
program to check that the subject to be measured is the one you
claim him to be.

If necessary, you can override any of the data in the preparation
simply by redoing the relevant parts of the settings. For example,
you can redo the head digitization, if there is any doubt that the
HPI coils are not at the same positions as they were at the time of
the preparation.

NM21781A

Experiment preparation 32



Elekta Neuromag DATA ACQUISITION

6. ACQUISITION

Oncethe setup iscomplete, subject is seated under the magnetom-
eter, the HPI coils and EEG €lectrodes have been connected as
described in the hardware manual, and the shielded room door is
closed, you can start the actual acquisition.

6.1. Acquisition controls

The acquisition control buttons are:

1. GO!

Start the acquisition. If the parameters have been changed or
if this is your first acquisition, the acquisition system is
informed about the new parametersfirst. Thereafter, the mag-
netometer electronicsis set to the correct state including ana-
log filter settings.

Depending on the changes needed this procedure may take
10 — 30 seconds. The log window shows messages about the
conversation with the data collection server. Oncethe setupis
complete, a New measurement is starting... message
appears on the first message line below the acquisition con-
trol buttons.

2. Stimulate

If you are using externa triggering this button aways
remains dimmed. With internal triggering, you can test the
stimuli without acquiring any data. Therefore, the button is
enabled whenever a valid internal triggering is selected.
When datais collected you can switch theinternal triggerson
and off by clicking this button. Y ou can also switch the inter-
nal stimuli on without actually starting acquisition from GO!
(not supported by al data acquisition systems).

3. Average

This button switches on-line averaging on and off. It is
enabled when data are being collected. If internal triggering
isused, the default stateis on: the averaging can be controlled
by switching the stimuli on and off. With external triggering,
averaging is solely controlled by the state of this button.
Therefore, averaging is off by default for external triggering.

4. Record raw

Recording of raw (spontaneous) data is independent of on-
line averaging. Y ou can switch the raw data recording on and
off at will during the acquisition. The amount of data col-
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lected in seconds and megabytes as well as the space remain-
ing on the acquisition hard disk is displayed on the second

message line of megacq.
5. Restart

You can restart the acquisition by clicking this button. All
raw data and on-line averages collected will be discarded and
you can redo the head-position indicator measurement (see
Section 6.2.)

6. Stop
Stop the acquisition, see Section 6.7.

Sometimesit might be necessary to reset the MEG and EEG chan-
nels after an excessively strong magnetic or electric disturbance.
This can be done while a measurement isin progress by selecting
Reset channels... from the Tools menu. On-line averaging and
raw data recording should be turned off before doing reset and
they should be kept off until all the channels have settled again.
Otherwise the data could be spoiled by the huge signals involved
in the reset operation.

Note!

The extent to which the EEG channels are reset depends on the
configuration of the site. If the EEG system is controlled com-
pletely independently of the Neuromag system, the reset applies
only to the digital high-pass filtersin the data acquisition system,
and thus is probably not sufficient to recover a saturated EEG
channel. Should this happen, first reset the EEG amplifier system
and after that use Reset channels... to makethe channelsto settle
faster. Refer to the installation-specific technical documentation
for details.

6.2. Head position indicator

If you have digitized the HPI coil locations as described in Sec-
tion 4.2., you can localize subject’ s head with respect to the mag-
netometer. Right after the data collection has started.

6.2.1. HPI acquisition

The HPI measurement dialog gives you the following choices:
Measure

M easure the magnetic field generated by current fed into the
HPI coils and determine the location of each coil. During the
measurement you will see messages on the last message line
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of the megacq main window. If no signals are seen or if they
are considered too noisy, you will get an error message.
Should this happen, check that the coils are properly con-
nected and that the coils are working properly by rechecking
them with the HPI coil tester.

Once the measurement is complete, the positions are fitted.
When the fit completes, the results are reported as described
in Sect. 6.2.2., below.

The HPI procedure takes usually less than 10 seconds.
Try again

Redo the HPI measurement.
Reuse

If you have measured and fitted the HPI signals previously
with this Isotrak measurement, you can reuse the previous
data. Use this option with caution. If you have any doubt that
the head has moved since the last HPI measurement, use the
Measure choice instead.

Omit
Do not perform HPI localization at all.
6.2.2. HPI fitting

When the HPI signals have been acquired, a fitting program is
started to find out the locations of the coils. HPI fitting takesfrom
three to ten seconds.

When the fitting is complete, you will see a dialog with the fol-
lowing information:

1. Locationsof the HPI coilsin the device coordinates (see Sec-
tion 4.1. for the definition).

2. The goodness-of-fit value for each coil with an indication of
acceptance.

3. If some of the coils appear to be outside the helmet, an error
message appears after the coil location.

4. Distances between the coils as measured by the Isotrak digi-
tizer.

5. Distances between the coils from the fitting procedure.

6. A list of discrepancies between the distances measured by
Isotrak and calculated from the fitting procedure. Distances
larger than 5 mm areindicated, suggesting aneed to redo the
HPI measurement.

7. Location of the head coordinate system origin in device coor-
dinates.

8. Suggestion from the fitting program to accept or regject this
result.
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With the above information you can easily decide whether or not
you should accept the data.

With the buttons at the bottom of the dialog, you can either accept
the HPI data, redo the measurement, or omit HPI localization.

Warning!

If you stop the acquisition and you haven’t neither accepted nor
discarded the HPI result, no HPI datawill be available in the files
produced when you save the data.
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6.3. Raw data display

During acquisition the incoming data are displayed in a window
positioned to the right of megacq by default.

=l =]

MEG 1421
Y T e T e B e

MEG 1423WNWWWWWWMWWNM
MEG 1431

STI o0l |_|

STI o02 |I—||
STI o032

STI 004

STI 005

STI 00S

STI 014

5TI 015

5T1 016

i Selection... Rack Scales... [Colors... ’E

Thelength of the displayed raw datasegment isfixed and depends
on the sampling frequency and the number of channels acquired.

The name of each channel shown is indicated to the left of each
trace. Vertical linesare shown at a sel ectable spacing for time ref-
erence. The events detected on the stimulus input channels are
also shown by vertical lines if any of the stimulus input channels
are selected to the display.
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6.3.1. Controls

The following controls are located at the bottom of the window:
ST1 015

ST1 CiE

21 Selection... [Rack |Scales... |Colors... [xy

1. Channel selection buttons.

When you press the left or right arrow buttons the display
shows the previous or next set of channels, respectively.
Channel selections are discussed in detail in Section 6.3.2.

2. Pause!

Theraw datadisplay isfrozen, but the acquisition still contin-
ues. When the raw data display is frozen you can still move
through the channels with the channel selection buttons.

3. Selection...

This button invokes a dialog showing the currently selected
MEG channelsin graphical form. The shortcut buttons to go
to adesired selection are also located here.

4. Rack

When this toggle button is depressed the MEG channel num-
bering changes to electronics rack order. The change isindi-
cated by showing the channel names in a different color
selectable from Colors... button. The display order of chan-
nels stays the same independent of the numbering selected.
This button is useful in troubleshooting and identifying need
for adjustment of the SQUID electronics.

5. Scales...

When you press this button a dialog appears to change the
scales of various channel types and the spacing between ver-
tical time markers.

6. Colors...

When you press here a color definition dialog is shown to
change the colors of the components of the display.

7. xy

An oscilloscope-like display for sensor tuning pops up with
this button.

6.3.2. Channel selections

When you press the Selection... button in the raw data display
controlsthe window shown below appears. The sensor layout and
channel groups are different in Neuromag-122 and Vectorview
systems.
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Zelections

WMEG 09-10

MEG 11-12

MWMEG 13-14

MEG 15-16

The graphical display on the left indicates the currently selected
channels. The buttons on the right list the available selections
with descriptive names. There are two add-on selections available
to include additional channels to each selection:

Fixed electric

The first two electric (EEG, EOG, EMG, or ECG) channels
are added after the currently selected channels.
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Stimulus
Switch on/off displaying of stimulustrigger channels (signals
labelled as STI...).

Show layout

The channel layout on the left can be hidden with this func-
tion to make the selection window smaller.

If you are not happy with the standard sel ections, you can custom-
ize them in the following way:

1. Copy /neuro/ dacq/ setup/ rawdi sp. sel to the directory
. meg_anal ysi s under your home directory:

cp / neuro/ dacqg/ setup/ rawdi sp. sel ~/.nmeg_anal ysi s

2. Editthefile~/. meg_anal ysi s/ rawdi sp. sel withatext edi-
tor to match your needs.

Each linein thisfile correspondsto a selection. The format of
each lineis:

<selection name>:<ch name 1>|<ch name 2>|...

For example:
My sel ection: MEG 001| MEG 002| MEG 003

The channel names are identical to those listed in the channel
selection dialog, see Section 3.3. on page 11.
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6.3.3. Scales

The vertical scales can be controlled by the Scales... dialog
whereasthe time span of the raw data display isdetermined by the
chosen sampling rate and the number of channels selected for
acquisition, and it can not be changed. However, the time marks
can be set to appear at user specified intervals by the Scales...
dialog. The default scales can be configured by qualified service
personnel.

+] Remove dc offset

Magnetometer (Vectorview) and axia gradiometer channels typ-
ically require wider display scales than planar gradiometer chan-
nels. The axial sensor scale multiplier (Axial Mult) multipliesthe
MEG scale figure to set the vertical scale for axial gradiometer
and magnetometer channels.

By default, raw data display subtracts the average signal ampli-
tude calculated over the display time span from each sample thus
keeping the signal traces on the display even when strong low fre-
guency signal components are present. This behavior can be
switched on and off by toggling the Remove DC offset button.
This affects only the display and not the raw data being recorded
to afile.

If an on-line signal space projection operator (see Section 3.7.) is
used, the projection for the display can be controlled by the Apply
SSP button. Note that this doesn’t have any effect on the raw data
recording.
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6.3.4. XY display

The tuning of the SQUID sensors can be done without an analog
oscilloscope by using the XY display incorporated in the raw data
display. The XY display shows the signal from one channel at a
time; the Y (vertical) deflection is driven by the output of the
selected channel whereas the X (horizontal) deflection is driven
by the excitation signal fed to the SQUIDs in the tune mode.

=l Oscilloscope |

[« [» MEG 0112

In the Vectorview system, the XY display works in conjunction
with the Squiddler program so that selecting achannel in Squid-
dler automatically selects the same channel for the XY display.

Changing the channel selection in the raw data display switches
the XY display to show thefirst channel in the newly selected set.
Thereafter, the arrow buttons can be used to select any individual
channel.

6.4. On-line averaging

6.4.1. Messages

As mentioned in Section 6.1., on-line averaging is switched on
and off from the Average control button. The number of
responses averaged into each category is listed on the third mes-
sageline. If an epoch isregjected from the average, amessage indi-
cating this is displayed on the fourth message line. The Epoch
rejected message will remain for a while even if subsequent
epochs are again accepted. Reasons for the rgjections arelisted in
the log message area at the top of the main control window.
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6.4.2. Adjusting on-line averaging

You will notice that the on-line averaging setup button remains
active even during acquisition. Therefore, you can change the on-
line averaging parameters during acquisition. If you accept the
changes, all existing averages are cleared and the averaging is
started from beginning. Changes to the on-line averaging param-
eters do not affect the raw data collection.

6.4.3. Marking channelsas “bad”

Y ou can set channelsto beignored from the on-line artefact rejec-
tion procedure from the dialog that appears when you select Set
bad channels... from On-line menu. If some channels are caus-
ing rejections and you would like to continue without rectifying
the problem, check the corresponding channels in the bad chan-
nels dialog. The ignored channels will be marked ‘bad’ in the
resulting evoked-response output files but their signals will nev-
ertheless be present in both average and raw data files unlike
those channels that are turned off.

6.4.4. On-line aver age display

During averaging, partial results are displayed at selectable inter-
vals in the standard plotting program, xplotter, as discussed in
Section 3.5.6. Y ou can manipulate the display of responses (filter-
ing, baselines, scales, etc.) in the xplotter window during acquisi-
tion.

If you would like to update the averages without waiting for the
selected time interval to elapse, select Update average display
from the On-line menu. When you schedule a display update
manually, the display update timer will be reset and the next
update will be scheduled to occur after the regular interval from
the manual display update.

The categories displayed on line are initially selected from the
averaging parameters dialog. You modify the selection of dis-
played categories and on-line display update rate from Select
displayed categories... in the On-line menu. The choices are
kept between acquisitions, i.e., any changes made here are equiv-
alent to modifying the standard averaging parameter dialog with
the exception that the on-line averaging is not restarted from the
beginning when you activate the changes from the OK button.

When on-line averaging completes, al categories averaged are
always displayed, regardless of the currently active display selec-
tion.
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6.5. Raw data recording

While the measurement is running you can start recording raw
data by using the Record raw button in the acquisition controls.
If you switch recording on and off several times during one mea-
surement, the separate segments of raw datawill be concatenated
into the same raw data file. Since al the segments will have time
tags referring to the actual measurement time, the different seg-
ments can be identified at the analysis phase.

The amount of raw data recorded as well as the amount of free
disk space are displayed on the second message line of megacqg.

6.6. EEG impedance measurements

The acquisition system allows easy measurement of EEG €elec-
trode impedances. When EEG channels have been activated, the
EEG impedance display pops up automatically when a measure-
ment is started.

4 EEG Impedance Check

EEG 001 I NF
EEG 002 D NF
EEG 003 I NF
EEG 004 D NF
EEG 005 I NF
EEG 006 [ NF
EEG 007 | NF
EEG 008 [ NF
EEG 009 I NF
EEG 010 [ NF
EEG 011 [ NF
EEG 012 I NF
EEG 013 D NF
EEG 014 I NF
EEG 015 [ NF
EEG 016 [ NF
EEG 017 [ NF
EEG 018 [ NF
EEG 019 [ NF
EEG 020 [ NF
EEG 021 I NF
EEG 022 N NF
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Warning

Theimpedances are measured by checking the small check-box at
the left upper corner of the dialog. When the impedance measure-
ment is started EEG system starts feeding probe currents to the
el ectrodes and measures the resulting voltages. The amplitudes of
the voltages are shown as impedance values on the dialog.

The display has color coding indicating high resistance (red),
intermediate resistance (yellow). and low resistance (green).

To stop the impedance measurement, click the check-box again.

Currents are fed to the el ectrodes during the impedance measure-
ment. This prevents making normal EEG measurementswhilethe
impedance measurement is on.

6.7. Stopping the acquisition

When you have collected the desired number of responsesinto the
averages and you have collected al necessary raw data, press
Stop to finish the acquisition. If on-line evoked-response averag-
ing was requested, the save dialog for evoked-response data will
appear automatically once al data have been processed. After the
evoked-response data are stored, a dialog prompting for the raw
data file name will appear if any raw data were collected.

If you choose not to save either data, the system will emit a“last
chance” message when starting a new measurement which would
destroy these data.

See Section 7.2. " Saving averages and raw data’ on page 46 for
details about saving your data.
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7. SAVING DATA

7.1. Data volumes

Acquired data are saved to one of the predefined data volumes.
Under the volume top level directory, the datafiles will be stored
in

<project>/ <last name>_<first name>/ <date>,

if you are studying a volunteer, or

<project>/ case_<id>/ <date>

if your subject is a patient, as explained in Section 3.2.2.

If no subject name has been selected, the subject part of the path
will beno_nare.

If the volume is a removable one (magneto-optical disk, MOD)
you must first mount the volume to make it usable. Before the
MOD can be removed from the drive, it must be released or
unmounted. Mounting and unmounting as well as other data vol-
ume management procedures are described in Section 8.2. on

page 48.

7.2. Saving averages and raw data

If any on-line averages were computed, a saving dialog appears
automatically to save them. Saving of averages blocks megacqg.
However, it only takes a few seconds.

The user isalso automatically prompted for saving raw dataif any
were recorded. Raw data saving is done in background. There-
fore, you can continue with the next acquisition while saving of
previously acquired raw datais still in progress. Y ou can iconify
the Raw data saving window.

If the recorded raw datafile size becomeslarger than apredefined
value (in normal configuration 2GB minus 100MB), the datafile
is closed and a new continuation file is created. The exact size of
the file can vary somewhat depending on how the internal blocks
exceed the limit. When this kind of a split measurement is saved,
the first segment is given the name which user writesinto the sav-
ing dialog. Rest of the segments have the same name with a dash
and arunning number appended (numbering starts from one).
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7.3. The saving dialog

test] 4, |

These data were measured with Neuromag=122 §,

Background saver ' I_I_

The saving dialog has the following components:

1
2.

3.

10.

An option menu to select the destination volume.

The root pathname of the selected volume and the amount of
free space on the volume.

The destination directory for the data.

A text field to enter the destination file name. Use only letters,
numbers and the underscore character in the file name. The
suffix .fif is appended automatically.

A text field to enter acomment to go with the data.

Real and login name of the current user, which are saved with
the data.

Status line indicating the state of saving.
Save button to start saving.
Stop button to interrupt saving.

Discard button to discard the data. Thisbutton really discards
the datain raw data saving.
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8. MANAGING DATA VOLUMES

8.1. Concepts

A data volume is a collection of data under some directory in the
hierarchical file directory structure. We call thisdirectory the vol-
ume root.

The data are located under the volume root under directories
<project name>/ <subject name>/ <date>

for example,
test/phantom_phyllis/940530

A volume may reside either on a hard disk or on a magneto-opti-
cal disk (MOD). A MOD volumeis also called aremovable vol-
ume.

A removable volume must be mounted before it can be accessed.
Mounting refers to joining the file system on a disk as an integral
part of the directory hierarchy. Before a MOD can be physically
removed, the disk must be removed or unmounted from the direc-
tory hierarchy. A disk can be unmounted only after all open files
on that disk have been closed. In addition no process should have
itsworking directory set to adirectory on that disk.

Before you can start using a new magneto-optical disk you must
initialize (“format”) the disk, i.e., create the file system structures
onthedisk. Thistask isdescribed under Section 8.2.5. on page 51.

8.2. Accessing data
8.2.1. Basics

All data volumes are accessible from the Data directory under the
Neuromag toolbox in CDE:
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When you double click the Data directory icon, a volume manip-
ulation window appears:

i 4.

< g up) InitValame

2. s

Hount¥ol uns ot ¥ ol wioe

Yolume:Fsyko

fils

Volume newNOD

This window contains:

1.

o 0k wN

7.

Anicon for each available datavolume. Theiconsarelabeled
Volume:<volume name>.

A volumeis an association between a symbolic volume name
and a point in the file directory structure, volume top level
directory.

MOD mounting icon (MountVolume)
MOD unmounting icon (UnmountVolume)
MOD initialization icon (InitVolume)
Volume listing icon (CatalogVolume)
Volume backup icon (BackupData)
Datarestore icon (RestoreData)

8.2.2. Displaying a volume

To display the contents of a volume, double click the icon of the
desired volume. If thisis a volume residing on a hard disk, the
contents of the top level directory is displayed. If the volumeisa
removable one, the system first checks that the volume is
mounted. If not, you are asked to mount the volumefirst (see Sec-
tion 8.2.3. on page 50).
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The contents of the data volumes are displayed in standard VUE
File manager windows. To learn about the VUE File manager,
please study the printed or on-line VUE documentation.

8.2.3. Mounting and unmounting

To mount aremovable volume, proceed as follows:

1. Insert thedisk into the magneto-optical disk drive. Thedrives
are usually labelled with the volume names.

2. Drag the volume icon corresponding to the MOD on top of
the MountVolume icon

or

Double click the MountVolume icon and enter the volume
name to the dialog that appears.

The MountVolume action first asks you to press return after the
MOD isinserted. Thereafter, it creates the mount point directory
(/ mod) in the workstation where the MOD drive is located.
Finally, the MOD is 'exported' to the workstation you are using
and made accessible there. Thisarrangement allows you to access
the MOD from the system you are directly connected to.

To unmount a removable volume,

Drag the volume icon corresponding to the MOD on top of
the UnmountVolume icon

or
Doubleclick theUnmountVolume icon and enter thevolume
name to the dialog that appears.

Sometimes it is not possible to unmount a volume. This is most
probably due to programs having files open or working directory
set to the volume you are trying to unmount. UnmountVolume
automatically checks these processes and provides you a list.
After you have quit the programs you can try unmount again.

8.2.4. Copying data

To copy files from volume A to volume B:
1. Open volume A by double clicking itsicon.

2. Goto thedirectory containing the source files within volume
A.

3. Dragthefilesto be copied onto the icon of volume B.
The copying operation creates the directory tree for the destina-

tion filesautomatically. At present, you cannot copy entire direc-
tory trees. If one of the filesyou drag is adirectory, it is skipped.
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War ning!

If you drag an icon from awindow displaying datafrom avolume
to a window displaying in another volume, the file is moved
instead of being copied. You can copy afile by holding the con-
trol key down before you start moving the icon.

8.2.5. Initializing MOD's

To initialize or reinitialize a MOD perform the following steps.
Notethat there-initialization irreversibly destroysall information
on the disk.

1. Insert thedisk into the magneto-optical disk drive. Thedrives
are labelled with the volume names.

2. Drag the volume icon corresponding to the MOD on top of
the InitVolume icon

or
Doubleclick the InitVolume icon and enter the volume name
to the dialog that appears.

It is recommended that you initialize both sides of a MOD under
the same session. If the MOD you inserted is already initialized
you are asked whether you want to reinitialize it. Just before start-
ing theinitialization InitVolume asks for afinal confirmation.

Warning!

Due to a bug in HP-UX the system crashes if you attempt to
mount a MOD during initialization.

8.3. Listing the contents of a volume

The CatalogVolume icon provides access to a script to compile
afull or apartial table of contents of avolume either to aterminal
window or to a printer.

To produce the listing, drag the volume icon corresponding to the
volumeMOD on top of the CatalogVolume icon.

Y ou will be asked a series of questions regarding the type of list-
ing you want to produce.
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8.4. Backing up a volume

Backing up refersto copying all or selected files of avolume onto
a DAT tape. Before starting the backup, insert a write-enabled
empty tape into the DAT drive. The current setup does not allow
appends to the tape. Therefore, be careful to label your tapes so
that valuable data are not accidentally overwritten.

If you are backing up an MOD, insert it into the drive (side A first
if thewhole disk isto be backed up) but do NOT mount the MOD.

The backup operation is started by dragging and dropping the cor-
responding volume icon on the BackupVolume icon. After that
you can choose to backup the whole volume or to restrict the oper-
ation to specific subdirectories, whichisuseful e.g. for backing up
only some of the projects on the selected volume. Y ou will pro-
vided with a list of the directories in the root directory of the
selected volume to make it easy to choose the projects to back up.

Finally, you will have the option to automatically verify the DAT
tape after the backup. The verification procedure rewinds the
tape, readsit, and printsalisting of all files and directories found
on the tape. Note that this takes ailmost as long as the actual
backup.

If you chose to backup awhole MOD, side A is first backed up,
and then you will be asked to turn the MOD. The fileson side B
will be appended onto the tape after the files from side A, so do
NOT gect and re-insert the tape at this point or you will overwrite
the backup of side A.

Note that all the backup operations will leave the original files
untouched.

8.5. Restoring data

This is the reverse operation of backing up, i.e. files stored on a
DAT tape are copied to an MOD or hard disk volume. Before try-
ing arestore, check that you have enough free space on the desti-
nation volume.

Insert the DAT tapeinto the drive and drag-n-drop the destination
volumeicon on the RestoreVolume icon. Follow theinstructions
on the screen.
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9. RESTARTING THE SOFTWARE

The data acquisition may under some circumstances either stop
prematurely or freeze with the following symptoms:

1.

2.

Megacq becomes nonresponsive for along time. When win-
dows covering megacq are moved, the exposed areas are not
repainted.

When megacq is started it fails to contact the data server.

Most common reasons for this are overloaded acquisition work-
station and networking problems. Y ou can recover the system by
restarting the acquisition software modules:

1.

2.
3.

Double click the Maintenance icon in Neuromag toolbox to
open the folder of maintenance actions.

Double click the RestartAcgPrograms icon.

Confirm that you really want to proceed by answeringy tothe
question appearing in the RestartAcqPrograms terminal
window.

Wait until the message

Restart conplete. Press <Enter> to cl ose
t he wi ndow

appears and press <Enter>.

If you have collected evoked-response or raw data and meg-
acq ceased to work after you pressed Stop, you can rescue
your data by double-clicking the RescueEvokedData or
RescueRawData icon in the Maintenance folder.

If thereis some datato be saved, you will first see adialog to
confirm that you would really like to proceed. Thereafter, a
standard megacq saving dialog (see Section 7.3) will appear.
Note that the rescued data will be saved under the project
directory called unknown if the real project name could not
be retrieved.

Restart megacq by double clicking the Acquisition icon in
the Neuromag toolbox.

If you have completed the HPI digitization, you will be given
achanceto usethe HPI data again. Alternatively, you can use
Load preparation in the file File menu which allows quick
restoration of the previous setup of the acquisition software.

Reload the SQUID tuning fileif the power-up tuning settings
are not optimal. Restore the EEG amplifier settings if not
using the defaults.
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